|
GETTING STARTED

NI SoftMotion™ Controller for
Ormec ServoWire SM Drives

This document provides step-by-step instructions for installing and getting
started with the NI SoftMotion Controller for Ormec ServoWire SM drives.

Refer to the Related Documentation section of this guide for a list of
additional documents associated with the NI SoftMotion Controller. Many
of these documents are available in Portable Document Format (PDF) on
ni.com/manuals.
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Conventions

»

bold

italic

monospace

The following conventions are used in this guide:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.
This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

Step 1. Verify Components

Hardware

Before you begin installing and configuring your motion control system,
make sure you have the following hardware and software components:

Development computer running Windows XP/2000.
OHCI compliant IEEE 1394 interface, cable, and documentation.

Ormec ServoWire SM drive and documentation.

[ S N

Compatible motor and power supply for the drive.
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Software

NI SoftMotion Controller CD. This CD contains the following
NI software products:

— NI SoftMotion Controller 1.0 or later.
—  NI-Motion 7.0 or later driver software.

— Measurement & Automation Explorer (MAX) 3.1.1 or later
configuration software.

— NI Motion Assistant 1.3 or later application prototyping software
(optional).
Ardence Real-Time Extensions (RTX) 5.5.

SW-PRO-NT . exe. This file includes installers for the Ormec
RTX5-DRYV 3.3.3 or later real-time 1394 driver software,
ServoWire Pro 3.3.0 or later configuration software, and
SMS-SMM-UPG 2.4.0 or later drive firmware.

SW-PRO-NI . exe is available for download from the Ormec Web site
at www . ormec . com. Contact your Ormec representative for more
information.

Application programming software and documentation.

— To create applications that run under Windows, use one of the
following software packages:

 LabVIEW 7.0 or later

e LabWindows™/CVI™ 7.0 or later
*  Microsoft Visual C++ 6.0 or later
e Microsoft Visual Basic 6.0 or later

—  To create applications that run on LabVIEW Real-Time (RT)
targets, use the LabVIEW Real-Time Module 7.1 or later.

Step 2. Install RTX

Complete the following steps to install RTX on the development computer:

Tip Refer to the RTX documentation for more information about completing the

following steps.

1.

2.
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Insert the RTX CD into the CD-ROM drive to display the RTX
installation screen.

Launch the Windows Device Manager.
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3. Inthe Windows Device Manager, verify that the Hardware Abstraction
Layer (HAL) on the development computer is compatible with RTX.

4. Ifnecessary, update the HAL on the development computer to an RTX
compatible type.

Follow the RTX installer prompts to install RTX.

6. Restart the computer and verify that the computer performs correctly.

RTX is installed.

Step 3. Configure the IEEE 1394 Port for RTX

If you are using a third-party device to provide the IEEE 1394 port for the
ServoWire SM drive, follow the instructions provided by the manufacturer
to correctly install the adapter.

Complete the following steps to configure the IEEE 1394 device for RTX:

@ Tip Refer to the RTX documentation for more information about completing the
following steps.

Convert the IEEE 1394 device into an RTX device.
2. Update the Windows device driver.

Verify that the IEEE 1394 device has a unique Interrupt Request (IRQ)
value.

Launch the Windows Device Manager.
b. Select to view the resources by type.
c. Determine if the IEEE 1394 device has a unique IRQ value.

e If the IEEE 1394 device has a unique IRQ value, close the
Device Manager and proceed to Step 4. Install Ormec
Software.

e Ifthe IEEE 1394 device does not have a unique IRQ value, set
the IRQ value to a unique value. Refer to the RTX
documentation for information about modifying device
properties.

@ Note It may take several tries to find and unused and unshared IRQ value. You may need
to insert the IEEE 1394 device into a different PCI slot in the computer in order to find a
unique IRQ value.

The IEEE 1394 port is correctly configured for RTX.
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Step 4. Install Ormec Software

Complete the following steps to install the ServoWire Pro configuration
software, RTXS5 real-time 1394 driver, and the latest drive firmware on the
development computer:

1. Launch SW-PRO-NI.exe.
2. On the SW-PRO-NI Installation screen, select Install Software.

3. Select ServoWire Pro, RTX5-DRYV Real-time 1394 driver, and
SMS-SMM-UPG.

Click Install all checked items.

Follow the installer prompts through the rest of the installation.

@ Tip To avoid having to load the ServoWire RTX drivers manually each time you restart
your system, you can select the option to run the drivers at Windows startup in the RTX
driver installation wizard.

6. Shut down the development computer.

The Ormec software is installed.

Step 5. Connect the ServoWire SM Drive

Complete the following steps to connect the ServoWire SM drive to your
motion control system.

@ Tip Refer to the ServoWire SM drive documentation for more information about
completing the following steps.

A Caution ServoWire SM drives do not support hot plugging. Shut down your motion
control system completely before adding or removing a ServoWire SM drive to/from your
system.

1. Connect the I/O necessary for your application to the drive. Refer to
Table 1 for a list of the I/O settings required by the NI SoftMotion
Controller.

Table 1. ServoWire SM Drive I/0 Settings Required by the NI SoftMotion Controller

Terminal Signal
IN1 Forward limit switch
IN2 Reverse limit switch
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Table 1. ServoWire SM Drive 1/0 Settings Required by the NI SoftMotion Controller

Terminal Signal
IN3 E-Stop, polarity is active low
OUT1 Digital output O
OouT2 Digital output 1
OUT3 Digital output 2
OouT 4 Inhibit out/brake
OUTS5 Digital output 3
ASEN High speed sensor input
BSEN High Speed sensor input
@ Note ServoWire SM drives do not provide connections for Home Switch or Inhibit In
signals.
2. Connect the ServoWire SM drive to a power supply and motor.
Connect the ServoWire SM drive to the development computer using
a standard IEEE 1394 cable.
4. Set the drive ID for the ServoWire SM drive.
@ Note Each ServoWire SM drive in your motion control system must have a unique drive

ID. Otherwise, your system may exhibit unpredictable behavior.

Step 6. Configure the ServoWire SM Dive

Complete the following steps to configure the ServoWire SM drive using
ServoWire Pro:

@ Tip Refer to the ServoWire Pro documentation for more information about completing the
following steps.

1. Power on the development computer.
2. Verify that the ServoWire RTX drivers are running.

If the ServoWire RTX drivers are not running, select Start»
Programs»Ormec RTX Drivers»Load RTX Drivers to start the
RTX drivers. The ServoWire RTX drivers must be running before you
launch ServoWire pro and configure the drive.

3. Launch ServoWire Pro.
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Create a new ServoWire Pro project.

5. Configure your project system settings.

a. Verify that the This project is for an SMLC and Using Motion
Objects Library options are not selected.

b. Set the drive type to SAC-SMS.

6. Add adrive to your project.
a. Select the model your drive.
b. Select the drive ID of the drive you are adding.
It is not necessary to use ServoWire Pro to configure the drive I/O. The
NI SoftMotion Controller uses the I/O settings specified in Table 1.
However, to avoid confusion, National Instruments recommends that
you set the drive inputs to General Purpose Input and the drive
outputs to Programmable Output.

7. Add amotor to the drive, and set the axis input command parameter to
Current.
Configure additional settings based on your application.

9. If necessary, repeat steps 6 and 7 to add additional drives to your
project.

10. Save the configuration file as DMORMCOM. SwSetup in the C: \
directory.

@ Note If you do not save your configuration file as DMORMCOM . SwSetup in the C: \
directory, you will not be able to add axes to the NI SoftMotion controller after it is
installed.

11. Run the SwUpgrade utility in ServoWire Pro to confirm the drive
firmware is version 2.4.0 or later.

12. Run the SwTune utility in ServoWire Pro to test your configuration and
tune the motor.

13. Exit ServoWire Pro.

The ServoWire SM drive is configured.

Step 7. Install the NI SoftMotion Controller

Complete the following steps to install the NI SoftMotion Controller:

1.

© National Instruments Corporation

Insert the NI SoftMotion Controller CD into your CD-ROM drive to
display the NI SoftMotion Controller installation screen.

Click Install NI SoftMotion Controller.
Select ServoWire SM Drives, and click Next.
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4. Follow the installer prompts through the rest of the installation.

Refer to the NI SoftMotion Controller ReadMe.html file after
installation is complete for last-minute information that is not included
in this document.

Your NI SoftMotion Controller is installed.

@ Tip To find NI SoftMotion Controller updates, visit ni . com/motion and select Drivers
and Updates. For support questions, visit ni .com/support/motion.

Step 8. Activate the NI SoftMotion Controller

This section describes how to activate the NI SoftMotion Controller and
add an axis to the controller.

Complete the following steps to activate the NI SoftMotion Controller:

1. Make sure that both the ServoWire RTX drivers and the LabVIEW
Run-Time Engine are running before you launch MAX. If necessary,
refer to the following instructions to start the ServoWire RTX drivers
and LabVIEW Run-Time Engine:

e To load the ServoWire RTX drivers, select Start»Programs»
Ormec RTX Drivers»Load RTX Drivers.

e To start the LabVIEW Run-Time Engine, right-click on the
LabVIEW for RTX Manager icon in the Windows system tray,
and select Start LabVIEW for RTX.

@ Note If the ServoWire RTX drivers and/or the LabVIEW Run-Time Engine is not running
before you launch MAX, a red circle with a white X will appear next to the NI SoftMotion
controller in MAX.

2. Launch MAX.

In the MAX configuration tree, expand Devices and Interfaces to
display a list of installed devices.

4. Expand NI Motion Devices to display a list of available motion
controllers.

Select the motion controller you want to activate.
6. On the MAX toolbar, click Activate Device.

Follow the prompts through the rest of the activation process.

The NI SoftMotion Controller is activated.
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Step 9. Add an Axis to the Controller

Complete the following steps to add an axis to the NI SoftMotion
Controller:

1. Right-click the name of the motion controller and select Add Axis.

2. Verify that the axis information is correct in the dialog box that
appears, and click Next.

@ Note To change the axis information, double-click the Device and Axis Number fields
and enter the correct information.

3. Click Finish.

An axis has been added to the NI SoftMotion Controller.

Step 10. Initialize the Axis

Before you initialize the axis and test your motion control system, verify
that all the motion hardware—including motors, drives, encoders, and
limits—is correctly installed. Refer to the appropriate hardware
documentation for installation instructions.

@ Note You must have a complete hardware setup to configure and test your motion control
system.

Use MAX to initialize the axis and test your motion control system. Refer
to the Measurement & Automation Explorer Help for Motion for specific
instructions.

Related Software

The following sections describe National Instruments software packages
that are useful for setting up and developing your motion control
application.

Measurement & Automation Explorer (MAX)

MAX, the National Instruments configuration utility, installs with the
‘\ f; NI SoftMotion Controller. You can use MAX to configure your motion

controller and other National Instruments hardware devices and to update
your National Instruments software.

To run MAX, double-click the MAX icon on your desktop, or navigate to
Start»Programs»National Instruments»Measurement & Automation.
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Figure 1 shows the MAX configuration window.
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Figure 1. MAX Configuration Window

NI-Motion is the driver software for National Instruments motion
controllers. You can use NI-Motion to create motion control applications
using LabVIEW, C/C++, and Visual Basic.

Refer to the NI-Motion User Manual for more information about creating
motion control applications using NI-Motion.

NI Motion Assistant

National Instruments Motion Assistant is a graphical prototyping tool you
can use to prototype motion control applications. Motion Assistant contains
features for simple and complex moves, graphical prototyping, and code

creation.
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Simple and Complex Moves

Motion Assistant offers several move types that represent the most often
used moves in motion control. Supported moves include the following:

¢ Reference moves reset axes to a known location or state.

»  Straight-line moves create simple point-to-point movement for basic
motion applications.

*  Arc moves enable circular, three-dimensional, and helical arc types.

*  Contouring moves allow any trajectory specified by a series of
coordinates.

Graphical Prototyping

Motion Assistant is a fully graphical interface that makes it easy for you to
prototype a motion application by creating a series of moves. The position,
velocity, and acceleration of the moves are graphed and editable in two and
three dimensions.

Code Creation

When you are finished creating a prototype of a motion control application,
you can use the Motion Assistant code creation feature to export LabVIEW
VIs or C/C++ code. You can use the exported code to complete the
application in LabVIEW, C, or C++. You also can use Motion Assistant to
generate code recipes that you can use to code a motion control application
in other text languages, such as Microsoft Visual Basic.

The code generation feature of Motion Assistant also creates placeholders
in the generated code or code recipes for non-motion code, such as data or
image acquisition, in any location you specify.

Advanced Features

Motion Assistant supports the digital output feature available with
NI SoftMotion Controllers. This feature is designed to synchronize or
coordinate external processes with moves.

The digital output feature allows you to write an ancillary digital output line
to the NI SoftMotion Controller under the following conditions:

*  Before Move Completes

*  After Move Completes

*  After Blend Completes
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Hardware Support

Motion Assistant is compatible with the NI SoftMotion Controller 1.0 or
later. The NI SoftMotion Controller supports Motion Assistant reference,
straight-line, and arc moves. Position Compare is not currently supported.

Related Documentation

This section summarizes each piece of documentation associated with your
NI SoftMotion Controller. Use this information to determine which piece
of documentation will be useful for your task.

e NI SoftMotion Controller ReadMe—This document contains
information about changes made to the NI SoftMotion Controller,
“What’s New” information, system requirements, and known issues.

e NI-Motion ReadMe—This document contains information about
changes made to the NI-Motion software, “What’s New” information,
system requirements, and known issues.

*  NI-Motion User Manual—This document provides task-based
information to guide you through each phase of designing and
executing a motion application. This document contains information
on selecting a motor, designing a basic move, designing a multi-axis
move, incorporating machine vision and data acquisition into motion
applications, and other common motion concepts, such as Bode
analysis, contouring, and breakpoints.

e NI-Motion VI Help—This help file for LabVIEW applications
provides detailed information about each VI, including a description,
control and input terminals, usage, illustrations (diagram or code), and
error codes.

*  NI-Motion Function Help—This help file for C and Visual Basic
applications includes dedicated function reference files, and provides
detailed information about each function, including a description of
the function, a list of the function parameters, illustrations, and error
codes.

e Measurement & Automation Explorer Help for Motion—This help file
provides information on using MAX to configure your motion
controller.

e Refer to the documentation included with your Ormec ServoWire SM
drive for specific information about the ServoWire SM drive and
ServoWire Pro software.

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents . txt file on your CD, or
ni.com/patents.

© 2005 National Instruments Corporation. Al rights reserved. 371090A-01 Apr05
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